
LOCAL ECOLOGICAL KNOWLEDGE ABOUT 
WATERSHED FUNCTIONS IN NORTHERN THAILAND 

 
A GUIDE TO USING THE AGROECOLOGICAL 

KNOWLEDGE TOOLKIT (AKT): 
 

 
 

Tim Pagella, Chalathon Choocharoen, Pornchai Preechapanya, Catharine Moss  
and  Fergus L. Sinclair 

 
School of Agricultural and Forest Sciences 

University of Wales, Bangor 
Gwynedd, LL57 2UW, UK 

 
World Agroforestry Centre, 

Chiang Mai, 
Thailand 

 
Watershed Management Division, 

Royal Forest Department, 
Thailand 

 
December, 2002. 

 

                                                                                                



Table of Contents 
 
 
 
Table of Contents ................................................................................................................... 1 
1. UPLAND WATERSHEDS OF NORTHERN THAILAND: ............................................ 2 

1.1 Local knowledge and knowledge based systems approaches ...................................... 2 
1.2 What is the purpose of this AKT guide? ...................................................................... 2 
1.3 Consulting Knowledge Bases....................................................................................... 3 
1.4 The Agroecological Knowledge Toolkit (AKT5) ........................................................ 3 

1.4.1 What is AKT?........................................................................................................ 3 
1.4.2 What is knowledge? .............................................................................................. 3 
1.4.3 What is a knowledge base?.................................................................................... 4 

2. THE NORTHERN THAILAND KNOWLEDGE BASES................................................ 5 
2.1 Context for Knowledge Base development .................................................................. 5 

3. HOW TO CONSULT KNOWLEDGE BASES............................................................... 12 
3.1 Using the guide:.......................................................................................................... 12 
3.2 A quick sightseeing tour around AKT5...................................................................... 12 
3.3 Exploring the knowledge bases: some highlights from local knowledge: ................. 20 

3.3.1 Nutrient and water cycling in miang gardens: Differences between farmers’ and 
scientists’ knowledge.................................................................................................... 20 
3.3.2 The rational behind farmers’ management of miang gardens ............................. 21 
3.3.3 The role of trees in watershed functions.............................................................. 22 
3.3.4 Bio-indicators of water quality ............................................................................ 23 

4. General Tasks ................................................................................................................... 24 
4.1 The main menus ......................................................................................................... 25 
4.2. Diagram Instructions ................................................................................................. 30 
4.3 Tools for automated reasoning tasks .......................................................................... 32 
4.4 Glossary...................................................................................................................... 33 

5. REFERENCES ................................................................................................................. 35 
 

 1 
 



1. UPLAND WATERSHEDS OF NORTHERN THAILAND: 
A GUIDE TO USING THE AGROECOLOGICAL KNOWLEDGE TOOLKIT (AKT): 
 
 

1.1 Local knowledge and knowledge based systems approaches 
 
There is an increasing awareness that local knowledge and practices should be recognized 
in development initiatives aimed at sustaining and improving the livelihoods of farming 
communities and the environment. Interest amongst institutions involved in research, 
education and development in investigation and documentation of local knowledge has 
grown significantly over the last few years. 
 
The University of Wales, Bangor is a leading institution in the development of a 
knowledge-based system (KBS) methodology to acquire and use local knowledge in 
research and development. The university spearheaded the development of this novel 
approach to acquire, store and use local ecological knowledge about agroecosystems in 
collaboration with various national and international research institutions in Asia, Africa 
and Latin America. It promotes systematic collection and collation of ecological knowledge 
from farmers and development professionals. The Agroecological Knowledge Toolkit 
(AKT5) is a tailor-made computer software package that enables representation of 
knowledge in a computer readable form facilitating exploration of local ecological 
knowledge using computer based search and reasoning facilities. 
 
Work so far has revealed that rural people often have sophisticated knowledge of ecological 
processes occurring in their environment and that local knowledge is largely 
complementary to scientific knowledge, but is often not taken seriously into account when 
planning research. While knowledge differs to some extent between communities, common 
frameworks and terminology may occur across large distances and people with similar 
agroecological circumstances in different geographical and cultural contexts may have 
similar perceptions. 
 
 

1.2 What is the purpose of this AKT guide? 
 
The instructions that follow will guide you through a number of knowledge bases created 
by staff from the Chiang Dao Watershed Research Station, of the Royal Forest Department 
operating from Chiang Mai Province in northern Thailand. By following these instructions 
you will be introduced gradually to the AKT software, at the same time as learning about 
elements of farmers’ knowledge concerning watershed function in the upland watersheds of 
northern Thailand.  
 
The use of explicit local ecological knowledge by the Royal Forest Department has been 
increasing since the concept was first introduced during research into watershed 
conservation conducted in the early nineties (Preechapanya, 1996). There have been an 
increasing number of initiatives that have been introduced to try and increase the level of 
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local stakeholder participation in forest conservation programmes and using local 
knowledge is considered integral in this type of programme.  
 
This guide is designed as a tool to assist new users in exploring local knowledge bases. 
This publication is not intended to guide users through the creation of their own knowledge 
bases. The methodology for creating new knowledge bases elicited from stratified samples 
of people using iterative semi-structured interviews can be found in the user manual- Dixon 
et al (2001). The principles of knowledge base creation have also been explained in Sinclair 
and Walker (1998) and Walker and Sinclair (1998) and you may wish to visit the AKT 
website at http://www.bangor.ac.uk/aforum  
 

1.3 Consulting Knowledge Bases 
 
Local knowledge can help researchers and development workers explain the rationale 
behind farmers’ actions and can contribute to making more effective decisions in 
developing appropriate solutions to development problems. Knowledge bases can be 
consulted in four main ways: 

• by viewing sets of statements that fall under specific topics, 
• by performing a search for particular terms (words), 
• by representing statements on a diagram and using these to investigate causal 

processes and 
• by using customized tools (small computer programs supplied with AKT that 

interrogate and reason with the knowledge base) 
 

1.4 The Agroecological Knowledge Toolkit (AKT5) 
 

1.4.1 What is AKT? 
 
AKT is a methodology and software that enables the user to create a knowledge base about 
a chosen topic such as watershed functions or ecological risks associated with miang 
(Camellia sinensis )1 production, by collating knowledge from a variety of sources (generally 
farmers, scientists, extension workers and scientific literature). So far, AKT has been used 
primarily as an analytical research tool. However, knowledge stored in this way can also be 
consulted by natural resource scientists, policy makers and development workers. This 
publication uses an approach pioneered in Ghana (Moss et al., 2001), to guide first time 
users through knowledge bases created in Thailand, by the Royal Forest Department. 
 

1.4.2 What is knowledge? 
 
To define knowledge is to enter a philosophical minefield; nevertheless an explicit 
definition is required in this context. For the purposes of AKT, knowledge is the outcome of 
the interpretation of data, independent of the interpreter. Data are recorded sets of 
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observations, that may be either qualitative or quantitative.  Knowledge is distinct from 
understanding, which is a result of the interpretation of knowledge or data and is specific to 
the interpreter. 
 

1.4.3 What is a knowledge base? 
 
A knowledge base is a store of knowledge. In AKT5, this consists of a collection of 
statements and taxonomic relationships. Each statement is tagged (referenced) with the 
source of knowledge (which is generally either a person or a document, although each 
statement may have a number of sources) 
The knowledge is organised according to a number of principles: 
 

• Topics arrange knowledge around specific subject areas e.g. ‘bio-indicators of clean 
water’, ‘pests of miang’. Topic hierarchies gather similar topics under broader areas 
e.g. ‘bio-indicators of clean water’ and ‘bio-indicators of still water’ both fall under 
the more general topic of ‘hydrological indicators’. 

 
• Object hierarchies organise knowledge about specific objects  under more generic 

terms e.g. Schima wallichi, Castinopsis acuminatissima and Dipterocarpus 
turbinatus are all types of tree utilised for firewood in miang gardens and would 
therefore fall under the more general object label ‘firewood species’, and share 
attributes that make them useful as firewood. 

 

 
A miang farmer in hill evergreen forest explaining the characteristics of  tree species in his 
tea garden. 
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2. THE NORTHERN THAILAND KNOWLEDGE BASES 
 

2.1 Context for Knowledge Base development 
 
There has been an increasing adoption of participatory techniques in managing Thailand’s 
populated forest areas. Alongside other participatory approaches such as participatory land 
use planning, the Watershed Management Division of the Royal Forest Department has 
been interested in the use of local knowledge for developing improved strategies for upland 
watershed management in northern Thailand. The acquisition of local knowledge using the 
AKT5 knowledge based systems approach was initiated by the Division in the early 
nineties, where the technique was used to study the sustainability of jungle tea farming 
systems in hill evergreen forest (Preechapanya, 1996). Since that time, the division has 
continued to gather local knowledge on a wide variety of topics throughout northern 
Thailand.  
 

Much of the work with local knowledge has centred on miang or ‘jungle tea’ farming 
systems. These systems are found in the northern region of Thailand. This region covers 
about 170 000 km2 of which about 54% is considered highland. Miang2 (Camellia sinensis) 
is indigenous to this region and is found in hill evergreen forest, which occurs at altitudes 
of between 900-2000m. The hill evergreen forests consist mainly of trees from the family 
Fagaceae, such as Castinopsis, Lithocarpus and Quercus species. Miang gardens are 
usually found at altitudes of between 900m-1400m. 
 

 
Interviewing a miang farmer working in hill evergreen forest near Ban Mae Mae. 
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2 Miang is the Thai name for fermented tea.  The fermentation process involves steaming the tea leaves and 
then storing them anaerobically. The final product is used throughout South East Asia and is chewed rather 
than drunk. 



 
Thai people living in the highlands of northern Thailand can be categorised as those who 
are culturally Thai and the indigenous Austro Asiatic hill tribe people (e.g. Khmu, Hmong, 
Lua’ and T’in). Thai people who have migrated to the highlands and ethnic minorities in 
the highlands grow miang tea in the hill evergreen forest using an indigenous agroforestry 
planting system. The customary method for establishing a miang garden, at least in the past, 
has been to remove some trees and ground flora from around already growing tea trees. 
Thus a garden may be a winding path cut through the forest for several hundred meters, 
wherever the tea trees may be growing. Nowadays it is more common for tea trees to be 
planted, which has resulted in more orthodox plot shapes and sizes. The clearing of trees 
results in rapid grass growth which then requires weeding. Farmers specifically remove 
bamboo from around tea trees because they believe there are allopathic effects of bamboo 
leaves that are detrimental to the tea. 
 
Farmers conserve forest trees around their tea bushes, because they think that the trees 
provide shade and recycle nutrients. The villagers see the larger trees as benign. They also 
value high water yields from their catchment both as a supply of water for domestic use and 
for turning hydroelectric generators that are operated in some villages. Villagers in miang 
villages seldom practice large scale shifting cultivation in their watershed because they 
value the forest trees. Some miang farmers, especially those from hill tribes do continue to 
practice limited rotational shifting cultivation or maintain small upland rice fields. This is 
especially true in areas where farmers would otherwise be dependant on lowland rice 
producers to provide their rice.  

 
Figure 1: A livelihood diagram from Mae Ton Luang village 
 

 6 
 

In these highland villages the majority of villagers work in their own tea gardens, although 
there are significant numbers of miang tea merchants and labourers who do not cultivate 
their own gardens, but live permanently in the villages and work on other peoples’ tea 



gardens. The livelihood diagram above (Figure 1) illustrates an example of a typical miang 
farming family. It should be noted that in many villages there are also significant numbers 
of seasonal labourers who come from countries bordering Thailand such as the Shan states 
within Myanmar. 
 
 
 
 
 
 
 
There are four major types of land use in miang 
farming: natural forest, miang tea gardens, 
homegardens and settlement areas. The natural 
forest tends to be restricted to the upper slopes 
of the mountains (above 1400m). These areas 
are left completely unmanaged. This is a picture 
of an older unmanaged tea garden gradually 
being incorporated back into the forest. 

 

 
 

The miang tea gardens are located along a 
mid altitude belt (900m-1400m) between the 
natural forest on the upper slopes and the 
homegardens and settlement areas on the 
lower slopes. It is often very difficult to 
clearly distinguish boundaries between the 
natural forest and the miang tea gardens 
because farmers often plant their tea trees 
within less dense natural forest. It has been 
shown that miang gardens may contain over 
80% of the evergreen forest plant 
biodiversity (Preechapanya et al,. 2001)This 
picture shows an older garden which has 
now become more open as management 
activities and firewood collection have 
increased. Miang farming requires a large 
amount of firewood for the fermentation 
process. Farmers are often legally restricted 
in where they can collect firewood from but 
by using easily pollarded tree species most 
farmers can meet their firewood demands 
from trees in their own miang gardens 
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Homegardens are small, 
intensively cultivated areas close 
to the house. They contain 
naturally occurring forest and 
planted fruit trees, herbs and 
vegetables for home consumption. 
Farmers also plant or retain fruit 
trees such as mango (Mangifera 
indica) and pomello (Citrus 
maxima) in the tea gardens. In 
addition, in tea gardens where 
livestock are not present, 
vegetables such as cabbage, 
coffee, taro, and garlic are grown 
occasionally in small fields. A 
recent introduction has been the 
development of firebreaks around 
the tea gardens. These normally 
follow the village boundary 
(which incorporates the miang 
gardens) and are maintained 
communally. Fire is a frequent 
hazard in the hill evergreen forest 
that will quickly devastate a tea 
garden as well as large sections of 

forest. Many of these fires start when farmers engage in slash and burn agriculture. 
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2.1 The Knowledge Bases 
 
The initial purpose behind the development of the knowledge bases was to explore 
sustainability issues connected to ecological management of miang (jungle tea) farming in 
the Hill Evergreen Forests. The latter knowledge bases were concerned primarily with 
watershed functions, in both the miang gardens and in the upland watersheds of northern 
Chiang Mai Province in general. 
 
The five knowledge bases are: 
 

1. ‘maetonluang’, 
 Ethnic Thai farmers knowledge of  production ecology and biotic interactions in the miang 
gardens in hill evergreen forest 
2. ‘maetonluang2’, 
 A knowledge base of scientific knowledge relating to the above system. 

3. ‘jungletea2a’, 
 This knowledge base explores local knowledge held by Karen miang farmers regarding 
specific characteristics of the plants that grow in their farming environment that impact upon 
watershed functions. 
4. ‘jungletea2b’, 
 This knowledge base explores local knowledge held by Thai miang farmers regarding 
specific characteristics of the plants that grow in their farming environment that impact upon 
watershed functions. 
5. ‘care3’, 
 This knowledge base was developed as part of an initial program investigating knowledge 
held on uses of local plants and animals as bio-indicators in such processes as soil erosion, 
soil fertility, water quality issues and weather prediction.  

 

 

The first two knowledge bases (‘maetonluang’ and ‘maetonluang2’) were the first knowledge bases 

developed in Thailand. The work focused on local ecological understanding and management 

actions of miang farmers in hill farming systems from the village on Mae Ton Luang. The 

knowledge bases were developed as part of a study into the sustainability of these farming systems 

and included the following topics:  

• 'The role of  vegetation in nutrient cycling' 

• 'The role of cattle in miang garden ecolgy' 

• The role of vegetation for tea garden microclimate 
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Cattle in a miang garden 

 

The jungletea 2a and 2b knowledge bases were developed after the initial ‘maetonluang’ kb. The 

knowledge bases were again developed from knowledge held by miang farmers but focused on 

comparison of knowledge held by two separate ethnic groups:  Karen and Thai miang farmers. The 

knowledge bases focused on farmers’ knowledge of the role of various plants in storing and cycling 

water in tea gardens. The knowledge bases also recorded some bio-indicator species used by 

farmers to determine water quality. The main purpose behind the development of these knowledge 

bases was to gather information on the types of tree species found around the miang gardens at this 

altitude and to explore which types of vegetation farmers felt were most suitable for enhancing 

water conservation and limiting erosion. This information could then be used in re-planting 

programs to help ensure suitable species were selected. 

 

 

The final knowledge base, Care3a was developed to explore the use of bio-indicators for 

determining water quality and weather prediction. The knowledge base contains knowledge from a 

broad range of ethnic groups and localities and was intended as a base line study from which further 

specific knowledge bases could be developed. The use of bio-indicator species appears to be in 

common use by local people and farmers in this region although this is not well documented. 
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Cataloging this knowledge was felt to be useful by both CareThailand and the RFD and would be 

useful in extension activity. 

 
 
An example of a ‘miang’ tree 
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3. HOW TO CONSULT KNOWLEDGE BASES 
 

3.1 Using the guide: 
 
A number of instruction sheets are included in this package that are aimed at enabling the 
user to consult the knowledge bases provided. It is suggested that the user start with A 
quick sightseeing tour around AKT to familiarise themselves with the different functions 
of the software. Once this is completed the user can then move on to consulting the 
knowledge bases on particular topics of interest using any of the examples provided: 
 
� Comparison of Local and Scientific Knowledge of Tea Garden ecology 
� Bio-indicator species of water quality in use in Northern Thailand 
� Key attributes of vegetation in watershed function in upper watersheds 
� Comparison of Thai and Karen knowledge, regarding watershed function in upper 
watersheds. 
 
These illustrate the type of knowledge contained in the knowledge bases and the way to 
access it. After completing the Quick sightseeing tour around AKT5 the user will be able 
to consult knowledge bases using topics, searches and diagram exploration. These skills are 
reinforced and developed in Exploring the knowledge bases; some highlights from local 
knowledge which introduces other examples from different knowledge bases and the use of 
AKT tools. Once the user has completed these sheets they should then be able to explore 
the knowledge bases independently of the instructions provided. Some information on 
performing basic functions such as opening, closing, selecting, saving and printing 
knowledge bases within AKT is included after these sections under General Tasks.A 
separate page, Diagram instructions shows how the diagram functions are used. 
Definitions of key terms and concepts used in the instructions and in the software are 
included in the Glossary. However, the user should note that not all functions of the 
software are explained in this publication because the same software is used for both 
creating and accessing knowledge bases. The User Manual (Dixon et al., 2001) provides a 
comprehensive guide to the software and creation of knowledge bases. 
 

3.2 A quick sightseeing tour around AKT5 
 

This quick tour around AKT with the maetonlaung knowledge base is designed to familiarise you 
with the AKT software and with the ways of manipulating knowledge bases. 
 
Getting Started: 
1. Load the AKT program onto your computer by clicking on the appropriate icon from the 
start menu. 
2. Open the maetonlaung.kb by selecting KB from the menu at the top left hand side of the 
page and choosing Open Kb… Then select the maetonlaung.kb and click on Open 
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Welcome Dialogue Box 
 
Read the welcome dialogue box to get an idea of what the knowledge base is about. Press Further 
Details to find out more about where, when and how the knowledge base was made. Click on 
Pictures/Diagrams. Read the text at the top and then view each picture by selecting it from the list, 
and then clicking on Select. When you have finished with each picture or diagram, click on the X at 
the top right hand corner to close it. These diagrams provide some background information about 
the livelihoods of the farmers who provided the knowledge. Click on Close to return to the 
Welcome screen. 
 
Switching the language of the Knowledge base (English-Thai, Thai-English) 
 
In some knowledge bases, including this one, it is possible to switch from English script to a largely 
Thai script. 3To access this function go to the Tool menu at the top left hand side of the page.  Scroll 
down to the Tools → System Tools → General → Transpose_formal_terms_and_synonyms 
(Kb, Position).  
 

 
 
A new dialogue box will appear. Click on Run. Another dialogue box is produced. Type in the 
name of the knowledge base (maetonlaung).  Then type ‘1’ in the second field. Once this is done 
press Continue and wait for the tool to run. (For large knowledge bases this can take a number of 
minutes). When the tool has finished running a ‘tool output’ is produced. Click on Close to close it 
(the output window may need to be manipulated to the left to expose the buttons). Then Close the 
list of tools and return to the main menu.( To return to the original format i.e. the English script, you 
would need to use the tool restore_original_terms(Kb) which is found in the same list of tools as 
Transpose_formal_terms_and_synonyms (Kb, Position).  
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3 This is achieved by manipulating the synonym function of the AKT program.  This then allows a substitution of all  
the formal terms in English for a synonyms written in Thai script. This requires the use of an AKT system tool. 



When viewing the statements and diagrams after converting the knowledge base into Thai script, 
you will see that some words remain in English. These are reserved words that have restricted 
meaning within the AKT5 system. Topics, topic hierarchies and sources cannot be switched 
using this tool and will  remain in whichever language they were originally written in. It is only 
formal terms and statements which can be viewed in the Thai translation. Computers with 
modern versions of Windows operating system will also be able to view the diagrams in Thai. 

 
Now press Topics 
 
 
Topic hierarchies 
 
 
Topics are ways of organizing information around particular subject areas e.g. Atmospheric 
temperature and Microclimate. In Topic Hierarchies information about specific subject areas is 
arranged under a more general subject label e.g. ‘Solar radiation and microclimate’ and ‘Soil 
moisture’ fall under the general topic hierarchy of  ‘The role of trees in Microclimate’ 
 
On the left you can see a list of topic hierarchies in the knowledge base. Highlight ‘The role of 
vegetation on tea garden microclimate’. On the right you will see a column containing a list of all 
topics in this topic hierarchy, to the right of this you will see ‘The role of vegetation on tea garden 
microclimate’ highlighted in blue and immediately below all the subtopics under it. 
 
Click on View Tree and scroll down the page. This shows you the full topic hierarchy. Click on 
Close. Select ‘Factors affecting soil moisture’ in the ‘Topics in hierarchy list. You will see that it 
now appears in the ‘Topic’ box with ‘The role of vegetation on tea garden microclimate’ specified 
as the supertopic above it and ‘Evaporation’ and ‘Rainfall’ specified as the subtopics below it. 
 
Highlight in turn each topic hierarchy listed in the Topic Hierarchies dialogue box (on the left-hand 
side of the screen). 
 
Question: What topics do the topic hierarchy ‘Erosion in Tea gardens’ cover? 
 
Press Close on both dialogue boxes to return to the Welcome Memo and Close again to arrive at the 
main menu. 
 
Sources 
 
Go to the main menu (top left) and select KB → Sources… 
 
Sources tell you the origin of the information contained in a statement. All statements have a 
source, which can be of two types: an interview with a person e.g. a farmer or a scientist, or a 
reference  to a written document e.g. a journal reference 
 
On the left is a list of all the sources interviewed for the knowledge base. Let us look at one of 
them. Highlight the name ‘Mr. B. Nokom’ and press Details. A dialog box appears giving you the 
name of the interviewers, interviewees and the date of the interview. You are also given the gender, 
age, and occupation of the interviewees and the location of the village where they live. If you press 
Memo, you will be given any further details that the person who developed the knowledge base felt 
were important. Press Close on all three dialogue boxes. 
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Topics 
 
From the main menu select KB → Topics… 
 
This gives you the list of all the topics in the knowledge base. Highlight ‘The role of cattle in miang 
gardens’ and press Details/Edit. In the dialogue box that appears you will see in the ‘Boolean 
Search String’ how the topic was created- it is a search for any of the following words- cattle or eat 
or manure or not_eat or trample_on or trampling. Click on the ‘Show use in statements’ at the 
bottom of the dialogue box and a list of all the statements on ‘The role of cattle in miang gardens’ 
will appear. There are 27 statements in all. Close the list of statements and the topic details. 
 
Try the same thing with the topic ‘The role of vegetation on tea garden microclimate’ 
 
Question: How many statements are there on The role of vegetation on tea garden microclimate ‘? 
 
All knowledge in the knowledge base is represented through statements – these are the basic 
units of the knowledge bases. There are 4 different types of statements. Attribute statements 
tell you about the properties (attributes) of something – they are descriptive. Causal statements 
give you information about causal relationships. Comparison statements compare the 
properties of two objects. Link statements represent knowledge that cannot be represented by 
the other  type of statements.  
Please be aware, when using the program, that AKT automatically generates a natural language 
translation in stylised English and that the same process will apply for the conversion into Thai, 
which will be explained in the relevant sections below 
 
You can see that 27 is a large number of statements to look through. We will now continue to look 
at smaller collections of knowledge. Close all open dialogue boxes and return to the main menu. 
 
Object hierarchies 
 
From the main menu select KB→ Object Hierarchies… 
 
Objects are words used to refer to physical or conceptual items e.g. pests, soil, cows, policy, 
household. Object hierarchies represent classifications that people use to organize their 
knowledge by arranging some objects as specific ‘types’ of more general objects e.g. Albzia 
odoratissima, Melia toosendan and Protium serratum are all species of trees with compound 
leaves. Albzia odoratissima, Melia toosendan and Protium serratum are all, therefore, subobjects 
of the more general object ‘Compound leaf trees’, and, ‘Compound leaf trees’ is a superobject of 
the objects Albzia odoratissima, Melia toosendan and Protium serratum. All statements that 
refer to the superobject are inherited by all its subobjects. 
 
On the left you can see a list of the object hierarchies in the knowledge base. Highlight ‘Farmer 
taxonomy’. On the right you will see a long column containing a list of all the objects in the 
hierarchy, to the right of this you will see ‘Farmer taxonomy’ highlighted in blue and immediately 
below all the sub-objects under it. 
 
Click on View Tree and scroll down the page. This shows you the full object hierarchy ‘trees’.  
 
Click on Close. Select ‘Compound leaf trees’ in the ‘objects in hierarchy’ list. You will see it now 
appears in the ‘Object’ box with ‘Farmer taxonomy’ specified as the superobject above it and a 
variety of trees specified as the subobjects below it. 
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Now Close all dialogue boxes. 
 
Formal Terms 
 
Formal terms are the key components of statements. Objects are one type of formal term. 
Other types include actions – activities with a human agent e.g. harvesting or planting, and 
processes – activities without a human agent e.g. decomposition or germination. You will notice 
that underscores  are used to connect words that make up a single term e.g. dark_green. Words 
that require a capital letter are with in quotes e.g. ‘Schima wallichi’. 
 
Press the downward arrow on “Type” next to the word ‘all’ to see the different types of formal 
terms. Select object. All the objects in the knowledge base are now listed. Scroll down and get an 
idea of the objects in the knowledge base. Highlight Camellia sinensis and press Details. 
 

 
 

 This provides you with a brief description including information on what type of formal term it is 
and a thumbnail photograph (if one is available). Click on the thumbnail to enlarge the picture and 
see the tea tree clearly.  
 
Understanding parts. 
 
Part of:  This dialogue box shows the superobject of the the formal term is a part of in the 
knowledge base 
Part:  This shows what parts the formal term has in statements. For example there are statements 
about the crown and the leaf of Camellia sinensis. 
 
The Definition is fairly self explanatory and provides further information about the plant Camellia 
sinensis. 
 
Synonyms The dialogue box  lists the synonyms attached to a specific formal term. During 
knowledge base development in Thailand, the standard practice has been to include the first 
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synonym as the Thai script translation. The second synonym is normally the common name used for 
the object. This is useful in Thailand, where different ethnic groups may well have different terms 
for trees, etc. (where possible all plants and animals are recorded in the knowledge bases using their 
scientific names). There is no limit to the number of synonyms that can be entered. 
  
 
Press Show use in Hierarchies. You will see that 'Camellia sinensis' appears in the object 
hierarchy ‘farmer taxonomy and plant taxonomy’. Press OK 
 
Press Show use in statements. The 4 statements that appear are all the statements in the knowledge 
base that mention 'Camellia sinensis'. 
 
 
Introduction to Diagrams 
 
Now repeat the process outlined above for the object ‘tea’ 
In the Details box,  press Show use in statements. 
Under ‘Diagram selection Type’ at the bottom of the dialogue box press All Statements 
 
The diagram that you see before you will show you all the statements with ‘Tea’ that can be 
represented diagrammatically. 
 
Diagrams are a way of representing the connections between statements. Only causal and link 
statements can be represented diagrammatically. One statement is represented by two nodes (a 
rectangular or oval box) connected by an arrow. The different colours and shapes of the nodes 
indicate different types of node – action, process, object and attribute nodes. The arrows 
represent the linkages between the nodes. It is possible to view diagrams in either English or 
Thai script with the latest version of Windows 2000. 
 
Press the Label Mode button once. This will now show a pair of arrows that an arrow pointed 
upwards signifies an increase in the value where as an downward pointing arrow would signify a 
decrease in the value associated with the attribute in the node. A * indicates a different value. If the 
Label mode is pressed again this gives you statements written on the diagram in full. You can make 
the statements more legible by dragging the nodes across the screen to separate them out. 
Alternatively you can drag the statements themselves around the screen. (If you press Show kb 
diagrams from the Diagram menu and select Diagram 110 you will see one that has been 
organised previously.) 
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If you want to find out what is meant by ‘Soil, moisture_content’, click on the Statements button 
on the right to get a list of all the statements represented on the diagram. Then select statement 239 
and click on Details. At the top of the dialogue box you will see the natural language statement and 
at the bottom the formal language equivalent. 
 
Statements are typed into the knowledge base as formal language statements using a formal 
grammar (like a code) specific to AKT. These are then translated by the AKT program into 
stylised natural language equivalents. This use of computer generated translation explains why 
some statements in the knowledge base do not sound like natural English (let alone Thai). 

 
Click on Formal terms, select moisture_content and click on Details. An explanation is given here. 
Close all the dialogue boxes and return to the diagram.  
 
When working with complex diagrams it is helpful to remember to switch the label off. Turn the 
label mode off by clicking once more on Label mode.  
 
Click on Navigate on the right hand side of the screen and then click on the node, ‘solar_radiation 
intensity’. (The Navigate button gives you the immediate causes and effects of each node). 
‘solar_radiation intensity’ will be highlighted in green and some additional nodes will appear 
connected to ‘solar_radiation intensity’. Carefully drag sideways all new nodes to reveal any further 
nodes underneath (by pressing the left-hand mouse button over the node and dragging the node 
away). The red lines indicate that there is more then one line or arrow on top of one another. 
 
Click the Navigate button again and click on ‘tea growth rate’ More nodes appear.  
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Continue to build up the diagram by selecting Navigate each time and clicking on one of the new 
nodes. 
 
When you have finished, go to the main menu (top left-hand corner) and select Diagram→Hide 
Diagrams. 
 
 
Boolean Search 
 
 
Go to the main menu (top left). Select KB→Boolean Search. Go to ‘Display KB terms of type’ and 
click on the downwards arrow to select ‘object’.  
 
Select ‘Imperata cylindrica’ Press Details to see the term’s synonym and then close the formal 
terms dialogue box. 
 
Now press Select and “Imperata cylindrica” will appear in the Boolean search string at the bottom 
of the dialogue box. Then press the AND button. Highlight ‘growth’ (a process) and press Select 
once more. (If you want to check the synonym for “growth” select Details.) Press Search. 7 
Statements will appear. These are the only statements in the knowledge base which include both 
‘Imperata cylindrica’ and ‘Growth’. 
 
In the Search Results dialogue box press Close. In the Boolean Search dialogue box press Clear. 
Now do the same thing again, selecting ‘Imperata cylindrica’ and ‘growth’, only this time using 
OR instead of AND. Press Search. 
 
Now you have 63 statements. This is because you have selected all the statements that include 
either ‘Imperata cylindrica’ or ‘growth’. 
 
In the Search Results press Close. In the Boolean Search keep Imperata cylindrica in the Boolean 
Search string but this time select ‘superobject’ in the search options box so that it is highlighted in 
the same manner as ‘object’. Press Search once more. You will have 34 statements because, 
besides the statements using Imperata cylindrica you have also selected the statements related to the 
superobject of Imperata cylindrica i.e. Ground flora with vertical leaf inclination angle 
 
Closing a Knowledge Base 
 
 
Close the knowledge base by selecting KB→Close KB… and close AKT by going to the 
main menu File→Exit from AKT 
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3.3 Exploring the knowledge bases: some highlights from local knowledge: 
 
Using the introduction to AKT guide it should now be possible to explore the knowledge 
recorded in the other knowledge bases. It is easiest initially to use the topics to explore the 
knowledge bases. Some of the initial findings from the work with local knowledge have 
been introduced below to help develop skills in navigating around knowledge bases. 
 
 
There are interesting comparisons to be made between knowledge bases, and sometimes 
knowledge on one subject can be found in more than one knowledge base. Therefore it is 
often useful to have more then one knowledge base open at once. To switch from one 
knowledge base to the next go to the main menu in the top left hand corner and select the 
KB menu. Then use Select Kb… to switch between the knowledge bases. 
 
 
 

3.3.1 Nutrient and water cycling in miang gardens: Differences between farmers’ and 
scientists’ knowledge. 
Knowledge bases used: maetonlaung and maetonluang2 
Possible Tools: topic_hierarchies_common 
 
The initial work in Mae Ton Laung suggested some interesting differences concerning the 
perceived interactions between larger trees and miang. The farmers interviewed hold the 
belief that larger trees are essentially benign and actually provide nutrients and water to the 
miang at different times during the growing season whereas the scientists interviewed 
suggest that there is no link. The farmers believe that the roots of the miang trees and the 
larger trees are entwined and this provides a conduit for the transfer to take place. This 
knowledge is important in that it provides an insight into the reasoning behind farmers’ 
decision making that leads to tree retention in these farming systems. The statements 
related to this can be found in the topics ‘The role of forest trees in nutrient cycle’ and 
‘The role of forest trees in the water cycle’. 
 
Another method of exploring the topics from these two knowledge bases is to use the tool 
‘topic_hierarchies_commom’. To do this you need to have both knowledge bases open. 
Then go to the Tools menu, then select Tools, then open tool file… select thai_tools . This 
will then bring up a tool list. From this tool list select ‘topic_hierarchies_commom’ (You 
should read the tools details if it is the first time you have used the tool). Click on run and 
then select the name of the hierarchy you are interested in.  
 
An example of an output using this tool is given below (The tool will also offer to draw 
diagrams for you): 
 
Topics for the hierarchy:  The role of  forest trees in nutrient cycle 
         The role of  forest trees in nutrient cycle 
 
Details for topic:  The role of  forest trees in nutrient cycle 
There are 18 statements in the maetonlaung knowledge base for the topic  The role of  forest trees in nutrient 

 20 
 



cycle 
 
Statements for  maetonlaung 
9:  the rate of nutrient transfer to tea root of Castanopsis armata root  is high if Castanopsis armata root  
entwine tea root  
91:  the rate of nutrient transfer to tea root of Ficus hirta root  is low if Ficus hirta root  entwine tea root  
92:  the rate of nutrient transfer to tea root of Albzia odoratissima root  is high if Albzia odoratissima root  
entwine tea root  
95:  the rate of nutrient transfer to tea root of Schima wallichii root  is high if Schima wallichii root  entwine 
tea root  
98:  the nutrient transfer to tea root of Sapium baccatum root  rate is medium if Sapium baccatum root  
entwine tea root  
132:  the rate of nutrient transfer to tea root of Adinandra integerima root  is high if Adinandra integerima root  
entwine tea root  
134:  the rate of nutrient transfer to tea root of Castanopsis acuminatissima root  is high if Castanopsis 
acuminatissima root  entwine tea root  
153:  the rate of nutrient transfer to tea root of Castanopsis calathiformis root  is high if Castanopsis 
calathiformis root  entwine tea root  
154:  the nutrient transfer to tea root of Protium serratum root  rate is medium if Protium serratum root  
entwine tea root  
155:  the rate of nutrient transfer to tea root of Quercus kingiana root  is high if Quercus kingiana root  
entwine tea root  
157:  the rate of nutrient transfer to tea root of Castanopsis diversiflolia root  is high if Castanopsis 
diversiflolia root  entwine tea root  
158:  the rate of nutrient transfer to tea root of Elaeocarpus floribundus root  is high if Elaeocarpus 
floribundus root  entwine tea root  
160:  the rate of nutrient transfer to tea root of Castanopsis cerebrina root  is high if Castanopsis cerebrina root  
entwine tea root  
164:  the rate of nutrient transfer to tea root of Eugenia albiflora root  is high if Eugenia albiflora root  entwine 
tea root  
165:  the rate of nutrient transfer to tea root of Lithocarpus elegan root  is high if Lithocarpus elegan root  
entwine tea root  
170:  the rate of nutrient transfer to tea root of Lithocarpus trachcarpus root  is high if Lithocarpus trachcarpus 
root  entwine tea root  
171:  the nutrient transfer to tea root of Melia toosendan root  rate is medium if Melia toosendan root  entwine 
tea root  
288: forest_tree root  transfer nutrient to tea root  
 
 
There are 1 statements in the maetonlaung2 knowledge base for the topic  The role of  forest trees in nutrient 
cycle 
 
Statements for  maetonlaung2 
228: forest_tree root  not_transfer nutrient to tea root  
 
 
Figure 2- Output from running tool ‘topic_hierarchies_commom’ 

3.3.2 The rational behind farmers’ management of miang gardens 
Knowledge bases used: maetonlaung, jungletea2a and jungletea2b 
 
These knowledge bases all contain information describing some of the more important 
management actions conducted by the farmers. This can be found in the topic 
Management Actions in all the knowledge bases. Exploring this topic one can see that:  
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• the miang farmers will only weed their gardens through the rainy season as this 
does not affect the soil moisture levels and hastens nutrient cycling in their gardens, 

• they also do not use terracing as from their experience this has no noticeable effect 
upon soil moisture levels 

• cattle are regarded as important in these systems and their role is explored in all the 
knowledge bases. To explore the role of cattle use the Boolean Search facility and 
search for ‘cattle’. If you also open the maetonlaung2.kb you will see that the 
scientists and the farmers are in general agreement about the role of cattle. 

 

3.3.3 The role of trees in watershed functions 
Knowledge bases used: jungletea2a and jungletea2b 
Possible Tools: Species report or common_formal_terms_ and_their_synonyms 
 
The jungletea knowledge bases provide a large amount of useful information about the role 
of tree species in watershed function. As discussed above farmers hold the belief that trees 
can provide water and nutrients to their miang crops. Some species are better suited to this 
process then others. The farmers often use a tree’s stem texture as an indicator of it’s ability 
to store water and thus how well it performs in water cycling. The Royal Forest Department 
are involved with tree planting exercises especially with Pinus kesiya. However many 
farmers are opposed to this tree. Some of the reasoning behind this can be explained by 
comparing Pinus kesiya with the other more common tree species such as Schima wallichi.  
This shows why farmers may feel that other species are more useful in this role. 
 
To view a list of tree species in the knowledge base, go to the object hierarchy ‘trees’. To 
find all the knowledge about one tree species in the object hierarchy use the tool 
species_report(Kb,Species). To do this go to the Tools menu, then select Tools, then 
System Tools, Knowledge Exploration and species_report. Click on run and then enter 
the name of the knowledge base and the name of the tree species you are interested in.  
 
Species =  Pinus kesiya 
INFORMATION SHEET FOR : Pinus kesiya 
 
HIERARCHY :     Bark textures of forest trees 
    wood texture is medium 
    Pinus kesiya 
  
SYNONYMS :sonsambai 
 
 
ATTRIBUTE STATEMENTS  :  
 the Pinus kesiya wood  texture is medium 
 the rate of thoughfall_energy_reduction of Pinus kesiya canopy  is low 
 the prevention_of_bank_erosion of Pinus kesiya root  ability is medium 
 the prevention_of_sheet_erosion of Pinus kesiya root  ability is medium 
 the rate of water_transfer of Pinus kesiya root  is low 
 the rate of Pinus kesiya stem  storage water  is low 
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CAUSAL STATEMENTS     :  
    none 
 
COMPARISON STATEMENTS :  
    none 
 
LINK STATEMENTS       :  
    none 
 
CONDITIONAL STATEMENTS :  
    none 
 
DERIVED STATEMENTS :  
    none 
Figure 3- Output from running tool ‘species_report’ 
 

3.3.4 Bio-indicators of water quality 
Knowledge bases used: care3a and jungletea2a 
Possible Tools: unique_sources, 
  
Finding sources of drinking water is an increasing problem. Scientific testing of water 
quality is beyond the reach of many of the poorer farmers and thus knowledge about 
common plant and animal species that can indicate clean water is very helpful. The work 
with bio-indicators revealed a number of species that are used commonly to determine 
water quality. These can be explored either by using the topics or by conducting a Boolean 
search for water quality. 
The tool ‘unique_sources’ will allow you to identify key informants within the knowledge 
bases. 
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4. General Tasks  
 
Opening a knowledge base 
 
To open a knowledge base go to the upper menu, click on KB →Open KB… , then select 
the knowledge base you want to open (e.g. pornchai3a.kb) and click on Open 
 
Dialogue boxes 
 
Users will notice that with AKT it is possible to have a large number of dialogue boxes 
open at the same time and these appear on the taskbar at the bottom of the screen. If new 
users find this confusing they should remember to close dialogue boxes once they are 
finished with them. 
 
Working with multiple knowledge bases 
 
You can have more than one knowledge base open at the same time, but you can only work 
interactively with one knowledge base at one time (unless you are using tools). The name 
of the current knowledge base is displayed at the top of the screen. To view which other 
knowledge bases are open go to KB→Select KB… . To switch between open knowledge 
bases you must then select the knowledge base you want and click on OK 
 
Printing parts of a knowledge base 
 
It is possible to print sets of statements and diagrams from AKT 
Printing Statements:  There are two options for printing statements. You may print them 
out directly from the knowledge base, or you may save them as a text file and open them in 
another application such as Word, to view and print them. When you have a set of 
statements in front of you that you wish to print or save, click on Print Statements. You 
will then be asked if you want to save them into a text file. If you do, click on Yes, if you 
wish to print the statements directly from AKT click on No 
 
Printing hierarchy diagrams:  You cannot print topic or object hierarchies directly from 
AKT. Instead you copy them onto the clipboard and then paste them onto another 
application such as PowerPoint, to view and print them. In order to do this, bring the 
diagram up on the screen (View Tree), then click on Copy to Clipboard. When you have 
done this, open the application that you wish to view them in, and click on the Paste 
command. 
 
Printing statement diagrams:  Statement diagrams (i.e. Diagrams that represent a set of 
statements from the knowledge base) can be printed either directly from AKT or copied to 
another application. To print a diagram directly from AKT go to your chosen diagram and 
click on Print Window. To copy statement diagrams to another application, follow the 
same procedure as for printing hierarchy diagrams. 
 
Saving a knowledge base 
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If you have made some alterations to the knowledge base which you want to save, e.g. by 
creating a diagram, you can save the altered knowledge base. Go to KB→Save Kb as… , 
specify a new name for the changed knowledge base and click on Save. 
 
Closing a knowledge base 
 
To close the current knowledge base, go to KB→Close Kb… 
 
Closing AKT 
 
To close AKT, go to File→Exit from AKT 
 
 
 
 

4.1 The main menus 
 
The Kb menu, the Diagram menu and the commands that appear alongside diagrams are 
explained in the following sections. The glossary section provides additional explanation of 
the terminology. 

The Kb menu: 
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This is a brief description of the operations that can be performed from the Kb menu.  

New Kb… 

The first step in creating a new knowledge base. Allows the user to name and save a new 
kb. 

Open Kb… 

Used to open a pre-existing knowledge base. 

Save Kb  

Used to save changes that have been made to a knowledge base. 

Save Kb As… 

Used to save a knowledge base by another name. 

Save Topic as Kb 

Allows the user to save a topic from an existing kb as a separate kb file. The user is 
presented with a list of topics in the kb, the user highlights a topic, clicks on ‘Select’ and 
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clicks on ‘Save as Kb’. The user must then specify a name for the new Kb and click on 
‘Save’. 

Close Kb…  

Used to close a knowledge base. 

Select Kb… 

It is possible to have more than one knowledge base open at the same time. ‘Select Kb’ 
enables the user to switch between any of the open Kbs. The user is presented with a list of 
open Kbs, highlights the Kb desired and clicks on ‘OK’. 

Boolean Search 

Allows the user to search the knowledge base. The user may choose from a number of 
different types of search term, and may combine search terms using the Boolean operators 
‘and’ and ‘or’. The ‘Search options’ box allows the user to search within object hierarchies. 
Search strings can also be saved in the form of topics by naming them under ‘Name of new 
topic’ and clicking on ‘Save’4. 

Formal Terms…  

Provides a list of all the different formal terms in the knowledge base. Highlighting a term 
and clicking on ‘Details’ will give the type of term, any definition and synonyms, allow the 
user to view statements that contain the term, and find out whether object terms are 
members of object hierarchies. The definitions of formal terms are also edited from here. 
‘New’ allows the user to create a new term. ‘Delete’ allows the user to delete a term. 
‘Close’ closes the dialogue box1. 

Object Hierarchies… 

Two dialogue boxes are produced with this command. 
Left hand dialogue box 
The box on the left provides a list of all the object hierarchies in the knowledge base. ‘New’ 
allows the user to create a new object hierarchy by naming and saving it. ‘Delete’ allows 
the user to delete an existing object hierarchy. ‘Close’ closes the dialogue box. 
Highlighting an object hierarchy from the list opens up a dialogue box on the right 
providing details of that object hierarchy.  
 
Right hand dialogue box 
Highlighting an object from the list on the left and clicking ‘Object Details’ gives its 
details. ‘Append’, ‘Detach’ and ‘Move/Copy’ are commands which allow the user to edit 
the object hierarchy. ‘View Tree’ allows the user to view the structure of the object 
hierarchy tree. ‘Memo’ allows the user to view, add, edit or delete further text notes about 
an object hierarchy. ‘Close’ closes the object hierarchy dialogue box1.  
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Welcome Memo… 

Provides background information about the knowledge base and its creation. ‘Topics’ 
produces a list of topic hierarchies in the knowledge base (see the section below).  ‘Further 
Details’ allows the user to view more information and includes a link – 
‘Pictures/Diagrams’ to images included with the knowledge base. The text may be edited 
and saved with ‘Save’. ‘Close’ closes the dialogue box1. 

Sources… 

Provides a list of all the interview and reference sources within the knowledge base. ‘New’ 
allows the user to create a new source of either the interview or reference type.  ‘Close’ and 
‘OK’ close the dialogue box. Highlighting a source on the left and clicking on ‘Details’ 
gives further information about that source. ‘Delete’ allows the user to delete a highlighted 
source1. 

Statements… 

Provides a list of all the statements in the knowledge base. A highlighted statement appears 
at the top of the page firstly in its computer generated translation version, and secondly in 
its formal language ‘coded’ equivalent. ‘Details’ allows the user to get further information 
about a highlighted statement. ‘Edit’ allows the user to edit a statement. ‘New’ allows the 
user to add a statement to the knowledge base by first specifying a source, then typing the 
statement in its formal coded form and saving it. ‘Delete’ allows the user to delete a 
highlighted statement. ‘Close’ closes the Statements dialogue box. The list of statements is 
in numerical order when the button on the left, above the list of statements, says 
‘Numerical’. Clicking on ‘Numerical’ orders the statements by type of statement as well 
as numerical order and changes the button to ‘Categories’. Clicking on ‘Categories’ brings 
the statements back to plain numerical order. At the bottom of the dialogue box under 
‘Diagram Selection Type’ ‘All Statements’ generates a diagram of all the statements listed. 
When a causal statement is highlighted, clicking on ‘Causes’ generates a diagram showing 
all the causes of that statement, clicking on ‘Effects’ shows all the effects. When a causal 
or link statement is highlighted, clicking on ‘Navigate’ generates a diagram of the 
statement and all other statements with direct links to it. N.B. only causal and link 
statements can be represented on an AKT diagram. ‘Print Statements’ allows the user to 
either print a list of statements directly form the Kb or save them as a text file for future 
reference.5  

Synonyms… 

Provides a list of all the synonyms used in the knowledge base. Highlighting a synonym 
and clicking on ‘Details’ brings up the details of that formal term. ‘New’ allows the user to 
create a new synonym by selecting from a list of formal terms and typing in its synonym 
equivalent. ‘Delete’ allows the user to delete a synonym. ‘Close’ closes the dialogue box. 

Topics… 
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Provides a list of all topics in the knowledge base. By highlighting a topic, clicking on 
‘Select’ and then ‘Search’ the user is provided with a list of statements for that topic. 
Topics can be combined with the Boolean search operators ‘and’ and ‘or’. ‘Details/Edit’ 
provides the details of the highlighted topic and allows the user to edit it. ‘New’ allows the 
user to create a new topic, ‘Delete’ allows the user to delete a topic, ‘Save as Kb’ allows 
the user to save a selected topic as a new separate kb file, and ‘Close’ closes the topics 
dialogue box6.   

Topic Hierarchies… 

Two dialogue boxes are produced with this command. 
Left hand dialogue box 
The box on the left provides a list of all the topic hierarchies in the knowledge base. ‘New’ 
allows the user to create a new topic hierarchy by selecting from a list of existing topics. 
‘Delete’ allows the user to delete an existing topic hierarchy. ‘Close’ closes the dialogue 
box. ‘Save topic hierarchy as new Kb’ allows the user to save a selected topic hierarchy 
as a new separate kb file. ‘View topic hierarchy statements’ brings up the statements of a 
selected topic hierarchy. Highlighting a topic hierarchy from the list on the left opens up a 
dialogue box on the right providing details of that topic hierarchy.  
Right hand dialogue box 
‘Memo’ allows the user to view, add, edit or delete further text notes about a topic 
hierarchy. ‘Close’ closes the object hierarchy dialogue box. Highlighting a topic from the 
list on the left and clicking ‘Topic Details’ gives its details. ‘Append’, ‘Detach’ and 
‘Move/Copy’ are commands which allow the user to edit the topic hierarchy. ‘Topic 
statements’ brings up the list of statements for a topic chosen from the list on the left. 
‘View Tree’ allows the user to view the structure of the topic hierarchy tree3. 
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4.2. Diagram Instructions 
 

 
 
Brief Description of the buttons on the left-hand side of Diagram Window 
 
‘Object’ 
‘Attribute’ These commands are only used when creating a knowledge base 
‘Process”   
‘Action”      
 
‘Delete’ Node/link or 
‘Hide’ Node/link 
Allows a user to hide a node or link on the diagram if necessary to increase clarity. Note underlying 
knowledge base is unchanged, and if diagram is redrawn the hidden link/nodes will be redrawn 
‘Show/Hide label’ 
Allows a user to turn on / off the labeling for a selected link. Select the button, then press the mouse 
‘left button’ down on the ‘start’ node and, holding the button down, move to the ‘end’ node and 
release the mouse button (Used to hide unwanted labels and improve the clarity of the diagram) 
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Brief Description of the buttons on right hand side of diagram window. 
 
‘Zoom in’ 
Allows more of the kb to be seen on the diagram (4 zoom levels) 
‘Zoom out’ 
Reduces the area to be seen on the diagram (4 zoom levels) 
‘Centre Zoom’ 
Click this button, place the mouse pointer over a node that you would like to appear in the centre of 
the diagram, and click once. The diagram will be re-positioned. 
‘Label Mode’ 
Clicks on this button will in turn 
1. Display symbol information for all the links on the diagram 
2. Display the stylised English/Thai labels for all the links on the diagram 
3. Remove all symbols/ link labels 
‘Refresh’ 
Refreshes the current window and returns any highlighted nodes to normal 
‘Undo’ 
Will undo the last Navigate, Causes or Effects operation 
‘Show Paths’ 
Will create a diagram showing all the possible paths between two or more highlighted nodes. The 
nodes can be highlighted by a right mouse double-click over the node, and will turn green. Another 
double click will return the node to normal. 
‘Print Window’ 
Prints a copy of the current diagram on the default system printer. The diagram will map onto either 
portrait or landscape mode. (Can also print a file) 
‘Navigate’ 
Will display on the same diagram all the parent and child nodes of the selected node. Click 
‘navigate’ then single click with the mouse on the required node 
‘Statement’ 
Produces a list of all the statements represented on the diagram 
 
‘Causes’ 
After clicking ‘Causes’ button, position new cursor over a node and click left-hand mouse button. 
AKT will now re-draw diagram showing all causal paths leading tp selected node 
‘Effects’ 
After clicking ‘Effects’ button, position new cursor over a node and click left-hand mouse button. 
AKT will now redraw diagram showing all the effects resulting from the selected node 
‘Select Diagram’ 
Allows user to quickly move backwards or forwards through the current set of diagrams 
 
Dragging of nodes across diagram 
Select any node by pressing the left mouse button down on it, then holding button down, move to a 
new position. The progress of the node can be seen with a dotted node shape 
Resizing nodes on all diagrams 
Select any node by pressing the mouse right button down on it, then holding button down resize 
node as required.  
Show all links associated with a selected node 
Double click left mouse button on required node, and all statements associated with the node will be 
listed. Details of the statement can then be shown, deleted or printed 
Highlight a particular node 
Double click right mouse button on required node, and node will turn green. By selecting 2 or more 
nodes and pressing the ‘Show Paths’ button, the system will create another diagram showing all the 
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possible paths between the 2 or more highlighted nodes. Another double click will return node to 
normal.  
 

4.3 Tools for automated reasoning tasks 
 
The ‘tools’ are subroutines in the AKT language that perform automated reasoning. System 
Tools come with the software while users with some experience can develop their own user 
tools relatively easily. These tools are implemented to process, analyse and compare 
knowledge in a much more powerful manner than otherwise possible using simple Boolean 
search operations. This feature allows the use of artificial intelligence techniques to explore 
knowledge bases. 
 
Tools are used primarily for two distinct functions. Many tools have been created to 
facilitate the development of knowledge bases. The other major use for tools is in 
knowledge base exploration, especially where more then one knowledge base is being 
interrogated at the same time.  
 
Tools that may be helpful include:   
 
Name of Tool Description Tool Location 
species_report Produce a report showing any information in the 

knowledge base about a specified formal term. 
System tools,  

term_search Tool will allow user to search for any term(s) throughout 
all the loaded Knowledge bases. 

thai_tool file 

topic_hierarchies_common This tool lists all the common topic hierarchies in all 
knowledge bases loaded and allows the user to search for 
a topic under one of those hierarchies with the option of 
drawing diagrams for the statements produced. 

thai_tool file 

unique_sources This tool will list all sources in a knowledge base and list 
how many statements from a knowledge base are 
attributable to each source 

thai_tool file 

common_formal_terms_ 
and_their_synonyms 

This tool produces a list of formal terms common to all 
loaded knowledge bases. It then retrieves the synonyms 
from each loaded knowledge base for each formal term. 

thai_tool file 

source_reference_and 
_interview 

This tool produces a list of formal terms common to all 
loaded knowledge bases. It then retrieves the synonyms 
from each loaded knowledge base for each formal term. 

thai_tool file 

 
The use of tools will be explained further in section 5 ‘Exploring the Knowledge Bases’.

 32 
 



 

4.4 Glossary 
 
Key terminology and concepts using AKT5 
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Action A type of formal term used to refer to a process carried out by 
humans for the purpose of managing crops or livestock, etc e.g. 
‘weeding’ or ‘planting’ 

AKT Agroecological Knowledge Toolkit: a methodology and software 
for creating knowledge bases 

Attribute A type of formal term used to describe an object, process or 
action. Attributes are generally measurable e.g. height, colour, 
frequency, rate, gradient, temperature. 

Boolean Search A keyword search mechanism for retrieving statements 
containing particular key words. Any combination of words may 
be used in conjunction with ‘and’ and ‘or’ 

Causal Statement A statement about the causal relationships between two objects, 
processes or actions 

Comparison A type of formal term used in comparison statements 
Comparison statement A statement comparing the properties of two objects 
Control structures When working with tools: program segments within AKT which 

control when and upon what knowledge primitives are used. 
Data A set of observations which may be quantitative or qualitative 
Diagram A way of graphically representing causal and link statements 
Formal language The restricted syntax (grammar) by which knowledge is coded 

into AKT 
Formal Term Terms (words) - the key components in a formal language 

statement that do not belong to the formal grammar 
Knowledge The outcome, independent of the interpreter, of the interpretation 

of data or information 
Knowledge base (Kb) An articulated and defined set of knowledge stored on a 

computer which can be accessed and processed systematically 
Link a) A type of formal term used in a link statement                             

b) On a diagram – the connection between two nodes represented 
by an arrow 

Link Statement A type of statement used to represent knowledge that cannot be 
represented by any other type of statement 

Local Knowledge Knowledge based on a locally derived understanding, formed by 
experience and understanding 

Memo A facility within AKT which provides additional explanatory 
information about a formal term, statement, diagram, topic or 
knowledge base 

Natural language statement A statement which has been automatically translated by AKT 
from the formal language to a stylised English or Thai language 
translation 

Navigate A command used when working with diagrams that adds to a 
diagram all the nodes immediately associated with a user 
selected node or statement 

Node Causal and link statements can be represented on a diagram by 
two nodes connected by a link. Thus a node is the diagrammatic 
representation of one half of a causal or link statement which 
appears as a rectangular or circular box. There are four types of 



node: i) objects, ii) processes, iii) actions and iv) attributes of 
either objects, processes or actions 

Object A type of formal term used to refer to a material or conceptual 
thing e.g. pests, miang garden or dew 

Object hierarchy A way of organising knowledge about specific objects under 
more generic terms e.g. Schima wallichi, Castinopsis 
acuminatissima and Dipterocarpus turbinatus are all types of 
‘firewood species’ 

Primitives Small program segments within AKT employed for  running a 
tool 

Process A type of formal term used to refer to a change or a flux in the 
real world e.g. decomposition, erosion 

Prolog (WinProlog) An artificial intelligence programming language used for 
developing AKT software 

Source The origin of the information contained within the statement. 
There are two types of sources: interview sources and reference 
sources 

Subobject (of an object) An object falling below another object in an object hierarchy e.g. 
‘chestnuts (Ko)’ will be a subobject of trees 

Superobject (of an object)    An object above another object in an object hierarchy. e.g., trees 
would be a superobject of ‘chestnuts (Ko)’ 

Synonym A word with the same meaning as a formal term, frequently used 
either to denote a local name for a specified botanical species, or 
as a method of switching between Thai script and English. There 
may be any number of synonyms. 

System tools Tools stored within AKT which can be used to interrogate and 
evaluate a knowledge base 

Tool A small computer program supplied with AKT that interrogates 
and reasons with the knowledge base 

Topic A collection of statements organised around a particular subject 
e.g. ‘bio-indicators of clean water’ or ‘miang pests’ 

Topic hierarchy A collection of topics organised under a broader subject area     
User defined tools Tools created by the knowledge base user that are stored 

separately to the main AKT program file with an .mcr extension 
Value A type of formal term that is always attached to an attribute and 

describes that attribute e.g. 5kg, yellow, high, increase 
WinAKT The old name for AKT: Agroforestry Knowledge Toolkit for 

Windows 
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